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Description 

The class will explore by doing all the major commands and options the Inventor Nesting Utility 
add-in has to offer: 
- Nest entire assemblies or individual Inventor sheet metal parts, extrusions and sketches  
- Nests on multiple rectangular sheets of same or varying dimensions or on roll material  
- Optimize nest efficiency (filler parts, tweak nesting parameters)  
- Read in DXFs and use layer mappings to guide the fabrication process  
- Explore associativity scenarios between 3D model and the generated nests  
- Export nest as DXF or 3D model  
- Generate NC toolpath using HSM CAM workflows  
- Explore nest reports and costing 
 

Speaker(s) 

 
Bob Van der Donck 
Principal UX Engineer Autodesk 
Bob is an electro-mechanical engineer with a keen interest in software both for industrial design and 
for creating CAD/CAM integrated solutions. In the past 25 years at Autodesk, he managed or led 
technical teams in various disciplines like quality control and product support. Bob has a proven 

Learning Objectives 

 Use all the functions in nesting utility at an intermediate level 

 Prepare the nested parts for CAM and create the 2D Profile operation to cut out the 
parts 

 Understand the nesting settings and workflows to use for metal, wood and 
composite materials 

 Know how to use AutoCAD and its file formats (DWG/DXF) in combination with 
Nesting Utility 
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track record in scripting and .NET applications based on various APIs. With his solid background in 
both product design and UX design, he created the UI for Autodesk's first integrated CAD/CAM 
solutions (Inventor HSM and Fusion CAM) and Autodesk's composites and cutting solutions 
(TruLaser, TruPlan, TruFiber and Nesting Utility). 
http://linkedin.com/in/bobvanderdonck  
 

 

Ravi Javia 
Product Manager Autodesk 
Ravi Javia is a Product Manager at Autodesk. Ravi graduated from Stevens Institute of Technology 
with BE in Mechanical Engineering (concentration in robotics and mechatronics) and an ME in 
Engineering Mgmt/Systems Engineering. He pursued his interest in Advanced Manufacturing while 
working with Magestic Systems Inc. which was later acquired by Autodesk in July 2014. Ravi has 
developed his expertise in nesting, cutting, and fabrication while working with various customers. 
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Introduction 
 
For the lab we will be using components of the master assembly called 
Slot Machine no harnesses.iam. The entire assembly is checked into a 
Vault hive, conveniently called …. Vault. We will not work with the main 
assembly itself as it contains over 375 components. For the sake of time, 
we will concentrate on three smaller sub-assemblies: 

 Cabinet.iam 

 Bill validator.iam 

 Slot stand.iam (please open, inspect BOM and close the assembly) 
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Pre-requisites: 

 

We will first need to re-enable the Vault software  
on your lab machine and checkout the files. 

1. Start the Vault server 
2. Login to the Vault server with  
3. Username = admin, no password 
4. Enable the Vault from the File menu 

 
 
 

5. Start Inventor 2019 
 

6. Familiarize yourself with the Vault ribbon 
 
 
 
 

7. Login to the Vault (use the default settings) 
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Chapter 1: Create a nest document 
The creation of a nest is a two-step process: shape extraction first followed 
by the actual nesting 

1. Shape extraction 
2. Nest study creation 

 

Shape extraction is the process that recognizes 2D closed loops in source 
files 

 Only one shape is extracted per source file 

 A shape can contain multiple internal or external loops but all are 
treated as atomic in the nesting process 

 
 

 
 
 
 
 
 
 
 
Nest results are stored in an .inest document, which is Nesting Utility’s 
own file format. There are multiple ways to create such an inest file and we 
will explore each of these: 
 

 Method 1: create a nest from the Nesting ribbon 

 Method 2: create a nest from the context menu of IPT/ IAM 

 Method 3: create a nest from the New menu + template 
(default or custom) 

 

 
 

Task 1.1: Create nests (method 1) from ribbon 
 

Step 1: Shape extraction 
a. In case you have any documents open, close all documents 
b. Start Nesting from the Nesting ribbon. This will 

automatically use the default .INEST template, no questions 
asked 
 
 
 
 

Figure 2 Internal vs. 
external loops 

Figure 1: Extracted shapes 

Figure 3 Nested shapes 

Figure 4 Nesting 
ribbon zero doc 
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c. Make sure the Calculate panel is docked under the Browser 
 
 
 
 

 
 
 
 
 

 

d. Start Sources dialog (extraction) 
e. Use Vault Source Files dropdown 

 
 

f. Select Slot stand.iam from the Slot Stand folder in the Vault 
This assembly ONLY contains extruded parts but with 3 
different materials 
 
 
 
 
 
 
 

g. Open (Check out all) of this assembly 
 

h. Sources dialog shows the extracted shapes 
 

 

 

 
 
 
 

                                                      Figure 8 Sources dialog 
 

i. Hit OK once progress bar has reached 100% 
This will display the shapes in graphics and populates the 
shape nodes in the browser 

 

Figure 9 Extracted shapes 

Figure 5 Calculate docking 
panel 

Figure 6 Add Vault source files 

Figure 7 Slot stand 
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j. Open the Options dialog and check the Sources arranged 
by material checkbox 

k. Set the Color display in the ribbon to Material 

 
 
 
 

l. Use the Nesting Properties command in the ribbon to  
get overview of all shapes. Verify the different material and 
the QTY of the parts either in the Source Nesting Properties 
dialog of by using the Properties on an individual shape  
 

 

Figure 11 Source Nesting Properties 
 

m. Select any shape on screen with RMB to bring up the 
marking menu and use the Properties command to verify 
QTY and material on an individual shape 

 

 

 

 

 
 
 
 
 
 

n. Open the Process Material Library 
 
 

Figure 10 Sources arranged by 
material 

Figure 13 Process material with automatically generated materials 

Figure 12 Shape 
properties 
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o. For the newly added materials, set following Packaging 
parameters:  
Length =100 inch 
Width = 50 inch  
 

 

Figure 14 After changing the packaging sizes 
 

Step 2: Nesting study 
a) Use the Create command to create a nest study 

Note that Multiple nest studies are possible per .inest doc 
b) All shapes are automatically selected but we want to filter 

out the small corner joint parts. To do this Delete Packaging 
2 (wood material with thickness of 2 in or 50.8mm) from the 
context menu after selecting the row in the Packaging 
section. 
This removes the packing but also all remaining shapes that 
use that material from the nest. 

c) Verify that the Automatically calculate nest checkbox is 
on 

d) Leave Job QTY with a single value of 1.  
The Job QTY is the multiplier that determines the total QTY  
Total QTY = Source QTY X Job QTY 
The Multi-value option is useful when you want to nest 
multiple assemblies and want each assembly to use a 
different Job QTY 

e) Leave Bind all shapes to sources checked (not to be 
confused with bind to material) 
The Bind check ON guarantees that the nest updates when 
shape properties change. Turn this check off if you want to 
override/freeze nest properties on a per nest basis. 
Unbound cells are shown with Orange background  

f) Hit OK to generate the nest 
g) Save the file as Nesting1.inest 

 

Figure 15 Creation of a Nesting Study 

Figure 16 Nesting study with two nests 
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h) From the Vault ribbon, Check-in the inest file in the Vault, 
close all files. 
 
 
 

i) Find the Nesting1.inest file in Vault and verify in the Uses 
pane that all file dependencies are correctly saved in Vault 
 
 
 
 
 
 
 

 

  

Figure 17 Dependencies 
check in Vault 
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Chapter 2: Terminology & browser & display & UI behavior 

 

Add-in uses client graphics which means minimal selection capability. 

Marking menu and cross-referencing between graphics and browser works 
as expected but there is no measuring capability unless you create a 3D 
Model from the nest (see later) 

All shapes are represented as flat faces without thickness (rotate the 
viewcube to verify) 

Dialogs are multi-threaded. This means you can start a new command 
while for instance a complex nest is being calculated. 

Task 2.1: Explore AutoZoom 
Autozoom allows you to zoom in fast to a particular node.  

a) Toggle off AutoZoom and select a node in the browser 
b) Toggle on AutoZoom and select the same node in the browser and 

note the difference 
c) Open the Sources dialog and make it as small as possible. 

What happens when you select a row in the Sources dialog? 
 
Some ribbon commands (Edit, Calculate, Export, 3D Model) are only 
enabled for relevant browser nodes 

Task2.2: Explore different command access methods 
a) Select any nest and then selected Edit in the ribbon 
b) Close the dialog, select the same nest and use the Properties 

context menu 
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c) Close the dialog and double click on the same nest. 
All three tasks should bring up the Edit Nest dialog. You decide 
which one you prefer. 

 

  

  



 
 

 

Page 12 

Chapter 3: Control the nest display 

Task 3.1: Control display from ribbon 
a) Toggle Shaded to Wireframe in the ribbon 

Wireframe is useful to relate the shape label to the legend as the 
shape label is positioned very close to the shape boundary. 
 

b) Toggle back to Shaded 
 

c) Colors 
Toggle between Material and Source and inspect the color change. 
The other color options allow visualization of which shapes are 
mirrored or rotated on the nest.  
 Note that the Nesting utility material color is unrelated to the 
Inventor Appearance of the material used in the source part. 
 
 
 
 
 
 
 
 
 
 
 
 

d) Object visibility 
Turn off the Dimensions, Header, Annotations, Fabrication info 
 
 
 
 
 
 
 
 
 

Task  3.2: Options dialog 

a) Options > Display tab > Nests 
Re-enable Dimensions, Header, Annotations, Fabrication info by 
checking the Enable checkboxes 
Note that these options work in tandem with Object visibility 

b) Options >Nests > header 
Change number of columns from 2 to 3 and add the Thickness to 
the display 

c) Options > Nests 
Change the Property name color from white to blue 

Figure 18 Using color to identify 
mirrored and rotated shapes 

Figure 19 Nesting study 
without text 
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Note that this is a necessary change if you want to work with the 
Presentation color scheme 
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Chapter 4: Create nests (method 2): from context menu 

This is the most comfortable method to use when you have already an 
Inventor part or assembly open in your session. The same technique can 
be used for both iam and individual ipt. 
 
When dealing with Inventor ipt and iam files you need to be aware of the 
following 
• Sheet metal ipt requires a flat pattern to be present 
• Automatic shape extraction rules for ipt  

 Extrusions and sketches can be extracted 

 Last unconsumed visible sketch then 

 First non-suppressed extrusion and uses the 
extrusion height as nest thickness 

 An ipt file containing STL meshes or “dumb” bodies with at 
least one flat face can also be extracted 

 No attempt is made to indirectly extract extrusions/sketches/flat 
from the parent of a derived part 

• Explicit shape extraction is possible by setting the Use for nesting flag 
and NestingThickness parameter (see later) 

• Automatic shape extraction rules for iam 
 BOM QTY dictates source QTY 
 BOM QTY overrides are honored 
 Excluding parts from nest 

 Not effective: Toggling visibility or using LOD 

 Effective methods are: 

• Setting QTY = 0 in assembly BOM 

• Disabling source in Nesting Utility 

• Deleting source in Sources dialog/browser. This is 
only temporary until you refresh. 

• Providers 
 Source Providers are used to apply automatic extraction rules  
 Each file type has a provider 
 Order of providers matters 

 
 
 
 
 
 

• Log file and log messages 
 Non-closed shapes 
 Overlapping shapes or lines 
 Sheet metal files with missing flat pattern etc. 

 
 

Figure 20 Various Source Providers 
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Task 4.1: Use Create Nest command 
a) Close all files and on the Vault tab Open and Check-out 

Cabinet\Bill Validator\Bill Validator.iam from Vault. 
This assembly contains a mix of sheet metal and regular ipt files 
 
 
 
 
 
 
 
 
 
 
 
 
 

b) From the Model browser, use Create Nest command from the 
context menu 

c) Select the Default template 
d) Hit OK 

A new .inest doc is opened and the Sources dialog automatically 
comes up 

e) Change the Source provider for part BV Housing Weldment – 
Base.ipt from Generic CAD to Inventor Sheet Metal 
Tip: you might need to move or add the Source Provider column to 
see it 

 
 
 
 

Task 4.2: Error correction 
 
a) While the Sources dialog is up and when progress is at 100%, note 

that there are errors. 
Check the error(s) by hovering over the row or by opening the Error log 
and identify the name of the error part 

b) Hit OK to preserve the extracted shapes 
c) Open BV Housing Weldment - Base.ipt by using context menu  

 
 
 
 

Figure 21 Open and check-out from Vault 

Figure 22 Create nest from Model browser 

Figure 23 Finding and opening the source 
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d) Create the flat pattern and save the file 
e) Return to the inest document and you will see a blue refresh icon on 

the part 
f) Use the Start Extract context menu to extract the correct shape 

 
 
 

 
 
 
 
Task 4.3: Recognize extrusions, sketches explicitly 
 

a) Open the Bill validator - guide.ipt part in a separate document. 
Verify that the first extrusion of the part was automatically 
extracted and the extrusion height used to define the material 
thickness. Let us produce this part differently by nesting it in a 
completely different direction. 

 

 

 

 

 

 

b) Add the yellow sketch at the end face and project the face in the 
sketch 
 

c) Flag the sketch as “Use for nesting” by using the context menu 
 

d) Edit Sketch1 and add the length dimension d55 =223.413 
 
 
 
 
 
 
 
 
 

Figure 24 Re-extracting 

Figure 26 sing a 2D sketch as 
shape 

Figure 25 Identifying alternative 
shapes 



 
 

 

Page 17 

e) Use the Nesting Thickness command on the root node and paste in 
the measured length in the dialog. 
This will create an Inventor model parameter NestingThickness = 
3.048 mm (or 0.12 in) 
If you want the thickness to be associative with model changes, it is 
better to assign the NestingThickness as a formula. 
 
 
 
 
 
 

f) Verify that NestingThickness exists in the Parameters dialog 
and set NestingThickness = d55 + 1mm (resulting in a value of 
224.413mm) 
 
 
 

g) Save the file and return to the inest document 
 

h) Use Start Extract on the modified Bill validator - guide.ipt node. 
Verify in the shape Properties that the material with the correct 
thickness and the correct shape is now extracted 

 

 
 
 
 
 
 
 
 
Task 4.4: Exclude parts 

a) Identify and Open part Bill Validator - Head.ipt. 
This is not a part suitable for nesting or it might even be a 
purchased part. We will eliminate it from the nesting process either 
by setting its BOM QTY in the assembly to 0 or better by disabling 
it in the nest itself. 
 
 
 
 
 

b) In the inest document, uncheck the Enabled flag on the node Bill 
Validator - Head.ipt  
 
 

Figure 27 Nesting thickness 
parameter 

Figure 28 All the 2D shapes of the bill 
validator 

Figure 29 Bill validator head 

Figure 30 Disabling a source 
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c) Create a new nest study with the default settings and verify that 
part Bill Validator - Head.ipt is not included 
 
Tip: If you used filters previously, you might need to Clear filters in 
the Nesting Study to see all selected shapes 
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Chapter 5: Custom Templates & Materials & Packaging 

Nesting parameters are set on the material but can be modified on-the-fly 
in the nest dialog during nest creation and nest edit. 

• Material: material, thickness, orientation parameters (rotate, 
deviation, increment), grain, frame, separation 
 
 
 
 

 
 

• Packaging: length, width, form, cost, trim 
 
 
 
 
 
 
 
 
 
 

• Nest dialogs: corner position, performance parameters 
 
 
 

 

Very Important: All Nesting Utility dialogs remember the last used 
parameter values and filter settings (blessing + curse). To increase 
predictability, we advise to store materials, packaging and provider choices 
in a custom template 

Task 5.1: Move material from cache to Inventor material library 
Skip this task if you have 2019.2.1 installed 

a) Open file Cabinet\Brackets\Bracket Monitor Connector.ipt. 
This component uses material Aluminum 3105-H12 that is in the 
Autodesk Material Library but not in the Inventor Material Library. 

b) Open the Inventor Material Library and add the cached material to 
the Inventor library in the Metal Category 
 

c) Close and restart Inventor so that this Inventor library change can 
take effect. 

 

Figure 31 Most important material properties 

Figure 32 Most important packaging properties 

Figure 33 Global nesting parameters 

Figure 34 From cache to Inventor 
Material Library 
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Task 5.2: Synchronize to existing materials 
First, we want to populate our template with existing Inventor materials that 
we frequently use 

a) New and use the Standard.inest template. 
b) Process Material library  

Verify that one default Generic material with thickness 0.12 in (=3 
mm) exists and that it contains one packaging with width x length = 
196.85x196.85 in^2 (=5x5 m^2) 

c) On the root node in this dialog, Add from provider and add the 
Aluminum 6061 and Aluminum 3105-H12 materials from Inventor. 
You can add even more or add all but we don’t want to bloat the 
template. 

d) Add thickness of 0.0625 to both materials (Inventor has no notion 
of thickness) and leave the Material grain =0 

e) Uncheck all orientation related checkboxes and set  
Orientation= 0 deg 
Increment= 0 deg 
Material grain = 0 deg 
 
These particular settings give the shapes few degrees of freedom 
and will increase nesting speed. 
More importantly, this guarantees that the nested parts will come 
out with a zero degree grain. 

 
 

 
 
 
 
 

f) Each material can have multiple packagings. 
On the first packaging of the Aluminum 6061 material, set  
Length = 40 in 
Width =20 in 
Form = Rectangular 
Cost = 1 
 
 
 

g) Add a second packaging to Aluminum 6061:  
Length = 200 in 
Width = 100 in 
Form = Rectangular 
Cost =3 (second packaging is 3 times as expensive as the first 
packaging ) 
 

Figure 35 Reducing degrees of freedom 
of a nest 

Figure 36 Smaller sized packaging 

Figure 37 Larger sized packaging 
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h) Important: Set the smallest packaging as the active packaging by 
double clicking. The active packaging is shown in bold and used by 
default for new nests. 
 
 
 
 

Task 5.3: Providers 
You can decide which providers to use and in which order. 
Provider choices are also remembered in template 

a) Open the Providers dialog from the expanded Management panel 
 
 
 

 

b) For ipt file type, leave only the Sheet Metal provider checked  
 
 
 
 
 
 
 
 
 

Task 5.4: Create a custom template 
a) Save Copy as Template with name Sheet metal only.inest. We will 

use this template next. 
b) Close the document (no need to save) 

 

  

Figure 39 Sheet metal provider 
selected 

Figure 38 Accessing Providers from 
the expanded panel 
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Chapter 6: Create advanced nests (method 3): from New 

Task 6.1: Extract sheet metal only 
a) Use File > New. This access often used when hand picking 

individual files to nest (files do not have to be part of the active 
Inventor project!) 

b) Select the custom inest template called Sheet metal only.inest. 

c) Open the cabinet.iam file. 
You will now have two documents open in the session.  

d) Create nest and use the Add to open document option  

Note that there is no longer a need to create Aluminum materials 
as they already exist in the template 
 

 

 
 
 
 

 

e) Verify in the Source Provider column that only sheet metal files are 
extracted 

f) Examine error log or use tooltip by hovering over the error 

g) Hit OK to save the extracted shapes 
 
 

Task 6.2: Modify geometry in a source part 
Material or BOM QTY changes only require a refresh of the assembly 
node. However geometry changes in the source require a re-extract of the 
shapes. All above changes of course will affect existing nests 
 
 

a) Locate the shape Weldment Door Rib in the Sources. 
Note that the shape is not filled. 

b) Use the marking menu to Open the source file Weldment Door 
Rib.ipt 

c) Un-suppress cut in Weldment Door Rib.ipt 
d) Use Start Extract from the context menu on the Weldment Door Rib 

Note that the error is corrected and new geometry is taken into 
account (also in any existing nests) 
 

Task 6.3: Filter out even more parts 
a) Start the Nesting Study dialog 

Figure 41 Aluminum material is 
already present in template 

Figure 40 Cabinet 
assembly 
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b) In the table Clear all filters (Tip: select in a random cell to refresh 
the display and see the result) 

c) Deselect all selected shapes 

d) Use column Filters to filter out all shapes except the shapes with 
Material = Aluminum 6061 and Thickness = 0.0625 in  

e) Add these shapes to the selection by checking the Selected 
checkboxes or by using the “Add to selection” context menu 

f) Hit OK to create the nest  
Close the error that pops up. We will solve the error in the next 
chapter. 
 
 
 

 

  

Figure 42 Problematic nests 
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Chapter 7: Edit a nest: increase efficiency 

The Nesting study itself cannot be edited but a nest can be edited to 
increase the nesting efficiency or simply make the nest work. 
A common way to increase efficiency is to change the packaging size, 
increase the (Job) QTY or add extra shapes to a nest. 

Task 7.1: Change packaging 
The most common mistake is to use shapes that are too large to fit on the 
sheet resulting on error dialogs as can be seen on the right. 
The solution is to increase the packaging size. 
 
 

a) Show the Source Properties and filter material on Aluminum 6061 

b) Move the Length (X) and Width (Y) columns to the left 

c) Add Area column by using Display Column context menu on 
column headers 

d) Sort the Length (X) and/or Width(Y) columns to find the shapes 
with the biggest size and compare this to the packaging size being 
used for those shapes 
Use source nesting properties to locate X,Y dimensions and 
compare to packaging dimensions 
In this sorted and filtered, you can clearly see that the Monitor – 
Housing part is the largest and might not fit on a packaging of size 
50x30 in^2 
 

 

Figure 43 Monitor-Housing is a large part 
 

e) From the table context menu, use Save View to store this view with 
name “FindArea” for later debugging use. 
You can flip back and forth between the FindArea view and the 
Default view. 

f) Edit the nest. 

g) Add the larger packaging to the nest for the parts that use material 
Aluminum 6061 
 

 

 

 
Figure 44 Addition of a larger 200x100 in^2 packaging 



 
 

 

Page 25 

 

Note that Material library and Packaging changes as well as 
geometry changes in the source file, force the nest to be out-of-
date and this sometimes requires a manual recalculation of 
existing nests. 
Use the Start all button in the Calculate panel or start individual 
nest calculations with Calculate context menu to update the nest in 
a manual fashion. 

 

 

 

Task 7.2: Change QTY 
 

a) Edit the nest and change the QTY of all shapes from 1 to 10 
b) Hit OK to proceed with the nest recalculation 
c) Observe that the Efficiency has increased 

 
Note: Source QTY and Job QTY are not accessible on an existing 
nest but Total QTY (in the QTY column) can be edited. 

 
 

Task 7.3: Add a Shape to a nest 
 
You can mix and match external ipt/dwg or ipt, unrelated to the current 
assembly to increase efficiency. 

a) Open the Sources dialog 
b) Add the Sample bracket.DXF file from the AutoCAD files folder 
c) Assign the Material ID to the material representing the  0.0625 thick 

Aluminum 

d) Change the Unit rule to Custom 
This enables edits in the Unit column 

e) Change the unit to cm 
Note that the original unit was in (indicated by the underscore) 
This means that we effectively will scale down the DXF files with a 
factor 2.54  

 

Figure 46 Customizing units for DXF or DWG 

Figure 45 Calculate panel in 
waiting mode 



 
 

 

Page 26 

f) Start Extract and hit OK to save the shape 
g) Edit the nest 
h) Hit the selection arrow in the Shapes to nest section of the dialog 
i) Select the sample bracket shape node in the browser. 

Note that nodes with the wrong material cannot be selected, which 
is signaled by the STOP cursor 

j) Change the QTY of the bracket from 1 to 20 
k) Hit OK to calculate the nest and note the efficiency increase 

 
 

 

  



 
 

 

Page 27 

Chapter 8: Edit a nest: Source properties 

By default the Source file properties are bound to the material. 
The bound (or read-only) cells are marked in a grey background. 
If Bind is unchecked, all source nesting properties are available for edit 
(cell background is white). Once an edit is made, the overridden cell 
background is marked in orange  
 

Task 8.1: Change the degrees of freedom of the nest 
Use of filtering/sorting/multi-edit to identify and unbind multiple shapes and 
change the orientation, rotate, mirror and flip values 

a) Verify the efficiency in the nest summary on the graphic screen 

b) Use Unbind all from the context menu of a nest or a nest study 

c) Edit the nest 

d) Check Flip/mirror/Rotate 90/Rotate180/Rotate 270 on the Hopper 
Handle.  

e) Change the initial Orientation to 45 and allow a Deviation of 45 deg 
with incremental steps of 5 deg. 
This allows the shape to rotate from -90 to +90 with 5 deg 
increments 

f) Increase QTY to 500  

 

Figure 47 Orange cells indicating values different from the material library 

g) Hit OK and the nest will automatically update 

h) Verify new efficiency in the nest summary (or during nest 
calculation in the Calculation panel) 

i) Verify that the Hopper handle shape now is used on the sheet with 
various orientations. 
 
 
 
 

j) Change the Color display in the ribbon to Nested Orientation to 
better distinguish the various shape orientations. 

 
 
 

 
 
 

  

Figure 48 Oblong in various 
orientations 

Figure 49 Two different colors indicating 
different orientations 
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Chapter 9 : Advanced nest optimization techniques 

Task 9.1: Tweak global nest parameters 
a) Set the Positioning & Performance parameters according to this 

image and verify you obtain the expected results 
 

 

Figure 50 More ambitious global nest parameters 

 
Tip: use the tooltips on the dropdown fields to understand the 
behavior. 
 

Task 9.2: Material usage method and inventory 
a) Edit the nest 
b) Set desired yield back to 80% (for time reasons) 
c) Make sure the smaller packaging is in pole position and both 
packagings have an infinite Inventory QTY 
d) Set the Material usage method = As listed 
 

 

Figure 51 Small packaging first with infinite inventor 

e) Hit OK to Calculate the nest 

 

Figure 52 Multi-sheet nest favoring the smaller packaging size 
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f) Edit the nest and the Inventory QTY of the small packaging to 1 
 

 

Figure 54 Reducing inventory to 1 
 

g) Hit Ok to generate the nest 
 
 
 
 
 
 
 
h) Set the Material usage method = Best Mix (or Best size) 
 
 
 
i) Hit Ok to generate the nest 
 
 
 
 
 
 
 
 
 
 

Task 9.3: Priority 
Determines which shapes will be cut first 
a) Edit the nest 
b) Set corner position to Upper right 
c) Set the priority of Monitor housing to 100  
      Note that the Monitor housing is nested first. 
 
 
 
 
 
 

Task 9.4: Sheet count 
Nesting utility does not replicate the display of identical sheets but only 
shows one of the identical sheets and subtly changes the way the sheet 

Figure 53 Favoring the larger packaging size 

Figure 55 Using Best mix/Best size 

Figure 56 Prioritizing the monitor housing 
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borders are displayed 
 
a) Edit the nest 
b) Delete the small packaging 
c) Set QTY on all rows to a high number like 300  
d) Set Stack size = 2 
e) Verify the high efficiency and the double borders around the sheet 
 
 
 
Double borders close to each other = multiple stacks 
Double borders further apart from each other = multiple identical 
sheets 
 
 
 
 

Chapter 10: Export nest as Inventor file  

Create 3D model command creates a multi-body ipt 

Tip: use the Make components command to obtain iam 

Task 10.1: Create 3D Model 
a) Create a second nest study in the same file and use the defaults 

 
 
 
 
 
 

b) Select a sheet of this new study (NOT a nest!) 
c) Use Create 3D Model from the ribbon (or from the context menu) 
d) Verify that you obtain a single ipt file with multiple bodies with the 

correct thickness and the correct material and appearance, 
identical to the original source file. 
 
 
 
 

e) Save the ipt 

 
 
 

  

Figure 57 Multiple plates 
and stacks per sheet 

Figure 58 New study with 
job QTY = 1 

Figure 59 Inventor 3D model of 
a nest 
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Chapter 11: Toolpath generation 

We will now generate NC toolpath using Inventor HSM add-in 

Task 11.1: Produce CAM files 
a) Use the ipt you just created 

b) Setup  
 
 
 
 
 

c) Use Operation type = Cutting and hit OK 

 

 
 
 

d) Create a 2DProfile operation 
 
 
 
 
 
 
 
 

e) In the 2DProfile > Tool tab, set  

a. Type = Plasma cutting 

b. Make sure Kerf width < Separation value used in the nest 

f) In the 2DProfile > Geometry tab  

a. Check Select same plane faces 

b. Loops = Inner loops 

c. Side = Start inside 

d. Select the FACE of one of the closed contours 

g) Duplicate the 2DProfile via the context menu 

a. Loops = Outer loops 

b. Side = Start outside 

c. Check Tabs 
 

h) Select both 2D Profile operations (or the Setup node)  

Figure 60 Cutting 
setup 

Figure 61 2DProfile operation 
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i) Simulate 
 

j) Select Setup and Post-process 

k) Hit the Setup button in the dialog and choose “Use personal post 
library” 

l) Browse to the Post-processors folder 

m) Use the Torchmate processor and generate the NC code 
Make sure to check Open NC file editor if you want to inspect the 
generated code 
 
 
 
 
 

  

Figure 63 Post-processing with 
Torchmate post 
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Chapter 12: Nest reports 

Task 12.1: Generate the default report 
a) Double click on any Report node under any nest node 

This opens the default report that contains a maximum of 
information 

b) Explore the report contents (sorting, Show vs. Hide) 

c) Print the report as PDF and open the PDF to verify  

d) Save the report to disk as a self-contained HTML file. 
This file can be sent to other machines or to colleagues without 
losing image information. 

Task 12.2: Customize the report 
a) Options > Report  

b) Change the Report template directory to 
C:\Users\Public\Documents\Autodesk\Nesting Utility 
2019\Samples\Report Templates 

c) Navigate in Windows Explorer to the file 
C:\Users\Public\Documents\Autodesk\Nesting Utility 
2019\Samples\Report Templates\example-template-full.html 

d) Edit the file  in Notepad or any other text editor 

a. Comment out the entire report-part-cost-pie-chart  <div> 
section (mandatory step if 2019.2.1 is not installed) 
 

    <!-- <div class="report-part-cost-pie-chart" 

      data-source="AvgMaterialNestedCost" 

      data-patterned="true" 

      data-pie-tab-visible="true" 

      data-pie-tab-percent-precision="4" 

      data-pie-tab-border-color="#999" 

      data-pie-tab-border-width="3" 

      data-pie-tab-line-color="#990" 

      data-pie-tab-line-width="10" 

      data-pie-tab-stretch="10"> 

    </div> --> 

 
 

b. Replace the report-source-parts section with 

 <div class="report-source-parts" 

  data-resizable-columns ="PartName"></div> 
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This allows the Part Name column to be resizable in case 
you use long part names. 

c. In the report-nesting-properties section 

i. Change the data-column-count from 3 to 1 

ii. Make the section visible by default by setting data-
start-visible = “true” 

iii. Hide some properties by adding a data-hidden-
properties line 
 

 <div class="report-nesting-properties"  

      data-collapsible="true" 

      data-start-visible="true" 

      data-column-count="1" 

      data-shown-categories= 

"Miscellaneous,Material,Optimization,Positioning"  

      data-shown-properties="Thickness,Material,Density" 

      data-hidden-properties= 

"TimeVsEffStr,TimeVsEffNum"> 

</div> 

 
e) Re-Open the report by double clicking in the browser 

f) Change the Report Template in the dropdown to example- 
template-full to see the resulting report 

 
 

  

Figure 64 report with a single 
column Nesting properties section 
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Chapter 13: Nest AutoCAD files 

Nesting utility can also extract shapes from DWG and DXF files. 
The difference with IPT files is that DXG/DXF files have no notion of 
material or thickness and the unit can be chosen freely. So it is the 
operator’s diligence to provide these. 
 

Task 13.1: Configure and nest DXF files 
 

a) Start a new nest file 

b) Start the Sources dialog 

c) Add the two DXF files from the AutoCAD files folder (sample.dxf 
and samplebracket.dxf) 

d) Start the Process Material Library and add a new material 
unrelated to any Inventor material 

Material = Kevlar 

Thickness = 0.1 in 

Category = Composites 
 
If no Sync to provider is used, such material and material category 
remains independent from the Inventor material library. This gives 
you more flexibility but the downside is that the end result will not 
use the correct appearance. Here is an example where Cork and 
Kevlar are defined.  
 

 

Figure 65 Creating nesting materials unrelated to Inventor materials 

e) Start the Nesting properties dialog and assign the Kevlar material 
to the DXF files by selecting the material in the Material Name 
column  
Note that the Material name is editable for DXF and DWG 

f) Set the Source QTY for samplebracket.dxf to 20 (as it is a small 
part) 

g) Return to the Sources dialog and set the Configuration for both files 
to  DefaultImportConfiguration.cfg 

h) Assign both parts a custom unit = cm 

i) Hit Start Extract followed by OK to extract the shapes 
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j) Create Nest Study 

Note that the small bracket is nested outside the larger part 

 

 

 

 
 
 

 

 

k) Open Options > Extract 

l) Hit “…” to edit the active configuration file in the Configuration 
Editor. We offer Configuration files for both extract and export. 
They allow to pre-set the layer maps for nestable and non-nestable 
entities, etch data, grain markers, junk and other parameters. 

 

 

 

 

m) Hit the + sign to make a copy of the default configuration file 
Call the new file CustomConfiguration1.cfg 

Figure 66 Smaller 
parts nested outside 
larger part 
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Figure 67 Creation a custom configuration for shape extraction 

n) Set the new configuration as the active configuration via the 
context menu or simply double click on the name. 

o) Hit the Source file “…” button and load the sample.dxf file 

p) Hit preview 

q) Change the map for layer 5 from Non-nestable entities to Nestable 
contours 

r) Hit Ok to save the configuration  

s) Sources and the Configuration for both files to  
CustomConfiguration1.cfg 

t) Re-extract and hit OK 

u) Re-calculate the nest  
Note that the small bracket is now nested inside the holes of the 
larger part 

 

 

 

 

Figure 68 Smaller 
parts nested inside 
larger part 
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Chapter 14: Export nest as AutoCAD file 

Individual or a series of sheets can be exported to DXF files. 
The export settings can also be pre-defined in configuration files. 

 

Task 14.1: Export sheets as DXF 
a) Open Options > Export  to verify location and name of the 

configurations and then you can exit the Options dialog.  

b) Select one or more nested sheets in the browser 

c) Use the Export command from the ribbon 

d) Enter any DXF file name 

e) This brings up the Export Configuration Editor dialog 

f) Add a new configuration and make it active 

g) Map Automatic to layer 25 

h) Hit the Preview button 
Note that the shape/file labels are ALWAYS preserved in the DXF 
output 

i) Hit OK to proceed with the DXF file creation 

j) Open the DXF in AutoCAD 
Note that the outside contours sit on layer 25 
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Chapter 15: Nest AnyCAD files 

Closed shapes can be extracted from bodies inside STEP, ProE , 
Solidworks files etc. if there is at least one flat face in the file that allows 
us to construct a 2D silhouette. However the AnyCAD file must first be 
imported and saved in Inventor IPT format. The same holds true for STL 
meshes that need to placed first inside ipt files. 

Silhouette recognition from AnyCAD bodies is triggered by the Generic 
CAD provider.  
 
 
 

Task 15.1: Extract shapes from STEP file 
a) Open and checkout file Cabinet\Monitor Shelf\Backplane 

\Backplane – PCB.ipt 
b) Suppress the Emboss1 feature (irrelevant for nesting) 
c) Save Copy as STEP 
d) Close the file 
e) Open the STEP file as Reference Model  
f) Measure the thickness of the PCB (0.063 in) 
g) Set the Nesting Thickness on the root node to 0.063 in 

(skip this step if you have 2019.2.1 installed) 
h) Save the IPT (important) 
i) Create Nest from a template that has the Generic CAD provider 

enabled. 

 

  

Figure 69 Using Generic CAD provider 
only 

Figure 70 Shape extracted from a STEP 
file 
Figure 71 Shape extracted from a STEP file 
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